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Glossary
Glossary

Glossary
Baud rate A measurement of a communication channel's signaling rate or 

information-carrying capacity. Communicating devices typically 
have configurable baud rates to provide compatibility with various 
speed communication networks. Higher baud rates generally 
provide faster data-refresh times.

CIMPLICITY HMI An industry-standard supervisory control and data acquisition 
(SCADA) software package providing flexible, accurate, and easy-to-
use graphics. CIMPLICITY® HMI is based on client-server 
architecture, consisting of Servers and Viewer workstations. Servers 
are responsible for the collection and distribution of data. Viewer 
workstations connect into Servers and have full access to the 
collected data for viewing and control actions. Servers and Viewer 
workstations can be easily networked together to share data without 
the need to replicate your database from node to node.

CIMPLICITY HMI Server 
Development

Allows you to create new projects and can also function as a runtime 
system

CIMPLICITY HMI Server 
Runtime

Can be used as runtime systems only. They do not support project 
configuration.

CIMPLICITY HMI Viewer 
Runtime

Connects to Servers for viewing data and control actions

Communication network A physical standard for wiring and interconnection of 
communicating devices. A communication network standard usually 
includes specifications of voltages, maximum cable-run lengths, 
shielding, termination, and cable requirements. RS485 and Ethernet 
are examples of communication-network standards.

Communication protocol A language or convention used for reliable transmission and 
reception of binary data. A communication protocol is often 
independent of the physical method or network used for 
transmission. Modbus and TCP/IP are examples of communication 
protocol standards.

DDE Dynamic data exchange. A Microsoft Windows standard for efficient 
sharing of data between applications on the same computer
PMCS INSTRUCTION MANUAL 1



GLOSSARY GLOSSARY
DDE/OPC Server A software application that typically runs in the background, 
gathering information from the network and providing the 
information in dynamic data exchange (DDE) and object linking and 
embedding for process control (OPC) format for use by one or more 
applications. The PMCS DDE/OPC Server is included in the PMCS 
Network & Device Configurator and comes in versions optimized for 
Ethernet TCP/IP or RS485 Modbus networks.

Ethernet An industry-standard communication network commonly used for 
local-area networks (LANs) of computers. Ethernet-based PMCS 
systems provide high-speed, reliable communications at 10 
megabits per second.

Ethernet gateway The gateway increases performance of a PMCS system through 
multiple Modbus networks and reduces overall wiring costs through 
reuse of existing Ethernet LAN wiring

Event logger A standard PMCS application that efficiently analyzes, sorts, and logs 
unusual system behavior, such as circuit breaker trips, 
undervoltages, and overcurrents. Extensive data-logging capabilities 
make it a useful tool for analyzing and predicting system 
maintenance patterns.

Host computer The computer running the PMCS DDE Server. All other computers 
running PMCS client programs are referred to as Remote Viewers, 
viewer workstations, or networked computers.

IED Intelligent electronic device

Interface Toolkit An optional PMCS tool used to quickly generate accurate and friendly 
graphical user interfaces. The Interface Toolkit provides dozens of 
wizards to efficiently create intelligent one-line diagrams and tabular 
displays.

Modbus RTU An industry-standard, nonproprietary communications protocol 
typically used in medium-speed networks (up to 38.4 kpbs) on RS485

Multinet An Ethernet communications module that allows connection for up 
to 32 Modbus devices, providing Modbus TCP/IP communications for 
these devices over Ethernet. This allows connection to fiberoptic LAN 
and WAN systems for remote access to data.

NetBEUI A network protocol usually used in small, department-size local-area 
networks of 1 to 200 clients

NetDDE A version of dynamic data exchange (DDE) that allows 
communications between applications running on different 
computers over network connections

ODBC Open database connectivity. An inter-application communication 
protocol required for certain PMCS client applications to share data. 
Automatically installed and configured as part of the PMCS 
installation.

PMCS Power Management Control System. GE's high-performance power-
management system for Windows, including open network 
protocols, waveform capture and analysis, and event logging.

PLC Programmable logic controller

RELT Reduced energy let-through instantaneous protection. A 
measurement displayed in PMCS for GTU devices.

RS485 An industry-standard communication network supporting up to 32 
networked devices. RS485 provides medium-speed, reliable 
communication transport through shielding, balanced transmission 
voltages, and termination.

RTD Resistive temperature device. This function varies resistance based 
on temperature.
2 PMCS INSTRUCTION MANUAL
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RTU Remote terminal unit. A microprocessor based device, such as a 
relay.

SCADA Supervisory control and data acquisition. A category of systems that 
primarily acquires data for logging and analysis, as well as providing 
supervisory control in applications without time-critical 
requirements. Power-management systems are a direct application 
of SCADA technology.

TCP/IP Transmission control protocol / Internet protocol. An industry-
standard protocol typically used on Ethernet or token-ring LANs.

Waveform capture A standard PMCS application that provides a window into power-
quality data in an electrical system. Waveform capture is used to 
view snapshots of voltage and current waveforms from various 
points in an electrical system to analyze harmonics and unusual 
system behavior.
PMCS INSTRUCTION MANUAL 3
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Chapter 1: Introduction
Introduction

Overview

The Power Management Control System (PMCS) accesses GE MultilinTM and third-party 
devices in a substation and provides graphical representations of status and energy 
trends, remote control, and automated responses. By optimizing methods used to control 
both processes and equipment, energy efficiency is realized.
PMCS is intended for installation with CIMPLICITY® HMI. The wizards contained in the PMCS 
software allow you to quickly build accurate and friendly user interfaces with CIMPLICITY. 
Installation of PMCS adds PMCS and EnerVistaTM IntegratorTM functionality to CIMPLICITY, 
where EnerVista Integrator integrates the comprehensive line of POWER LEADERTM 
devices, as well as many new Modbus remote terminal unit (RTU) devices and systems.
PMCS supports Ethernet and baud rates of up to 38.4 kbps on a Modbus-based network 
and 10 Mbps on an Ethernet TCP/IP network. This results in near real-time screen viewing 
and immediate access to critical event and alarm data.
This document provides and introduction to PMCS and outlines how to configure 
CIMPLICITY for PMCS and how to view information for devices. For information on devices 
supported, installation, and starting the software, see the PMCS Quickstart Guide.

Features
PMCS includes the following features that make the system powerful and easy to use:

• Compatible with industry-standard third-party supervisory control and data 
acquisition (SCADA) platforms

• Built-in Modbus RTU network compatibility for an open network architecture and high-
speed communications

• Built-in Ethernet TCP/IP network compatibility for high-speed communication and 
reduced wiring costs

• 3D virtual-device interaction with accurately reproduced device look and feel

• Improved waveform capture, including extensive analysis tools

• Comprehensive alarm and event reporting for immediate diagnosis of electrical 
system problems
PMCS INSTRUCTION MANUAL 5



OVERVIEW CHAPTER 1: INTRODUCTION
HMI application size
• 20,000 points/tags in human machine interface (HMI) database (30,000 maximum)

• 600 HMI alarms configured maximum

• 600 trended points (eight maximum per device)

• HMI I/O rates, alarm rates, and logging rates not to exceed 750 pts/sec

• 17 device types supported with two wizard types (Basic and Advanced) that can be 
configured using PowerBuilder

• 10% of tags connected to enterprise solution

• Web-enabled only via CIMPLICITY WebView; no waveform or event viewers

Special application issues
• No redundancy

Performance
Response times:

• One second or less to open an HMI screen

• One second update time to populate a screen per device per serial port (except for 
UR-series and ELVS400 devices)

• 4 to 7 second time delay to display event in PMCS Event Viewer

• One second response time to make device change (settings/command coil) not 
including device feedback

• 1000 device events/sec burst support

Configuration:

• Maximum 15 devices per serial port

• Device baud rates set to maximum 

• CIMPLICITY HMI points set for on-demand

• Devices supporting 125 register block reads

• Average CPU utilization <35%

• 99% system uptime

OPC client data items size
• Up to 65,000 points/tags in OPC clients 

• 10% of tags connected to enterprise solution
6 PMCS INSTRUCTION MANUAL
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Devices supported

PMCS supports GE Multilin and third-party devices, including Modbus-based devices.
The table outlines the devices supported. The numbered products 239, 339, and so on, are 
also referred to as SR239, SR339, and so on. Firmware revisions other than those listed 
may not be compatible. When in doubt, contact your GE Sales Representative or GE Digital 
Energy as outlined in the For further assistance section.

Table 1: Devices supported by PMCSDevices
Device family Device Firmware

ATS MX150 5.4x, 6.0x

MX250 5.4x, 6.0x

MX350 1.2x

UPS UPS, UPS LP, UPS SG 1.0

Trip Units/Switchgear Spectra MicroVersa Trip 5.1x

Enhanced MicroVersa Trip C 4.1x

Enhanced MicroVersa Trip D 4.1x

GTU (EntelliGuard TU Trip Unit) 7.0x

ELVS (Entellisys) 4.5x

MET 12.02.02

Meters/Switches PQM 3.3x to 3.6x

PQMII 1.0x to 2.2x

EPM1000 3.8x

EPM2000 1.0x

EPM2200 1.0x

EPM4000 3.8x

EPM5000P 2.4x

EPM5300P 2.4x

EPM5350P 2.4x

EPM6000 1.0x

EPM9450Q 2.1x

EPM9650Q 2.1x

EPM9800 6.1x

ML2400 3.0x

Distribution Feeder 350 1.2x to 1.4x

F35 2.6x to 5.9x

F60 2.6x to 5.9x

F650 1.6x to 5.4x

MIF 2 4.0

735/737 1.5x

750/760 3.6x to 7.4x

G30 4.4x to 5.9x

G60 2.6x to 5.9x

Generator 489 1.3x to 4.03x

D30 5.0x to 5.9x

D60 2.6x to 5.9x

D90Plus 1.8x
PMCS INSTRUCTION MANUAL 7
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PMCS includes a set of customized wizard screens for the devices listed in the following 
table.

Table 2: Customized wizard screens

Line Current Differential 
Protection

L30 5.6x to 5.9x

L60 2.6x to 5.9x

L90 2.6x to 5.9x

Transformer 745 2.4x to 5.2x

T35 2.6x to 5.9x

T60 2.6x to 5.9x

345 1.3x to 1.4x

Motor 239 2.3x to 2.7x

269+ 6.0x

339 1.3x to 1.4x

369 1.6x to 3.4x

469 2.5x to 5.1x

MM200 1.0x to 1.2x

MM300 1.2x to 1.5x

MMII 4.0x to 5.2x

MMIII 1.0 to 1.2x

RRTD 1.4x, 1.5x

SPM 2.0x, 2.1x

M60 2.6x to 5.9x

Network N60 3.4x to 5.9x

Bus B30 2.6x to 5.9x

B90 4.8x to 5.9x

Specialized C30 2.6x to 5.9x

C60 2.6x to 5.9x

C90Plus 1.6x to 1.8x

Miscellaneous MRPO 1.0

FIRETRACER 1.0

VERSAMAX 1.0

Device family Device

Trip Units/Switchgear Spectra MicroVersa Trip

Enhanced MicroVersa Trip C

Enhanced MicroVersa Trip D

GTU (EntelliGuard TU Trip Unit)

ELVS (Entellisys)

Meters PQM

PQMII

EPM9450Q

EPM9650Q

Distribution Feeder 735/737

750/760

Device family Device Firmware
8 PMCS INSTRUCTION MANUAL
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For further assistance

For product support, contact the information and call center as follows. Have your 
software key(s) ready.

GE Digital Energy
650 Markland Street
Markham, Ontario
Canada L6C 0M1
Worldwide telephone: +1 905 927 7070
Europe/Middle East/Africa telephone: +34 94 4854 88 54
North America toll-free: 1 877 547 8630
Fax: +1 905 927 5098
E-mail: multilin.tech@ge.com
Website: http://gedigitalenergy.com/multilin

Comments about new features or modifications for specific requirements are welcome.

Generator 489

Transformer 745

Motor 469

Universal Relays UR

Device family Device
PMCS INSTRUCTION MANUAL 9
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Chapter 2: Configure CIMPLICITY
Configure CIMPLICITY

To use PMCS in CIMPLICITY, the latter needs to be configured for it . This chapter outlines 
how to add a project for PMCS in CIMPLICITY.

Add PMCS project in CIMPLICITY

This section outlines how to place and configure a PMCS wizard in CIMPLICITY HMI. You do 
this by adding a project in CIMPLICITY for PMCS.
To add a PMCS project in CIMPLICITY:

1. In CIMPLICITY HMI, create a new project by clicking the New Project button or 
selecting File > New Project . A window opens.

2. Enter a Project Name and select a folder in which to store the project (usually in the 
cimplicity\hmi\projects\ folder). Under Options, select PMCS PowerBuilder and under 
Protocols, select OPC Client . Click the Create button to write the project file to disk 
and open the Project Properties window. See the following figure.
PMCS INSTRUCTION MANUAL 11



ADD PMCS PROJECT IN CIMPLICITY CHAPTER 2: CONFIGURE CIMPLICITY
Figure 1: Creating a new project in CIMPLICITY

3. In the Project Properties window, click the Options tab, and select the Enable project 
broadcast checkbox if you want to use CIMPLICITY HMI remote view nodes. Ensure 
that the Computer name field matches the name of the host machine. Disregard the 
Startup timeout field and the General tab. Click OK to open the CIMPLICITY HMI 
Project Wizard.
12 PMCS INSTRUCTION MANUAL
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Figure 2: Project Properties window

4. Complete the CIMPLICITY Project Wizard. At the end, click Finish to complete the 
setup.

Figure 3: CIMPLICITY Project Wizard

5. Access the CIMPLICITY Workbench view for the project.
PMCS INSTRUCTION MANUAL 13
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Figure 4: CIMPLICITY Workbench window

6. With CIMPLICITY Project no longer running, double-click the PMCS PowerBuilder item. 
When CIMPLICITY Project is still running, the following error message displays; close 
the project window. Once PMCS PowerBuilder has launched, you can view device data 
as outlined in the next chapter.

Figure 5: Error message when CIMPLICITY still running

With successful launch of PMCS PowerBuilder, any supported devices configured in 
the PMCS configurator display in a list. If this configuration has not been done, do so 
now using the Quickstart Guide, then run PowerBuilder after device configuration is 
complete.

On first run, PowerBuilder reads the device configuration details from the server topic 
files (TOPIC.CFG). It populate the list with configured devices in the default one-line 
options, as shown in the following figure.

On next run, PowerBuilder loads the device details from the topic files and sets the 
one-line preferences of already configured devices as per previous configuration. The 
Created check box is enabled for these devices.

The next chapter explains how to use the main PowerBuilder window and the 
information available for various devices.
14 PMCS INSTRUCTION MANUAL
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Figure 6: Devices listed in PMCS PowerBuilder
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Chapter 3: PowerBuilder window
PowerBuilder window

The main window PMCS PowerBuilder allows access to device information. This chapter 
explains the window. The information displayed was entered during installation of PMCS; to 
add devices, see the PMCS Quickstart Guide.

PowerBuilder window explained

To launch PowerBuilder, double-click the PMCS PowerBuilder menu item as outlined at the 
end of the previous chapter.

Figure 7: CIMPLICITY Workbench window

The following figure shows an example of the main PMCS PowerBuilder window. Devices 
with an ML prefix refer to GE Multilin products. Such products are referred to elsewhere in 
this document without the prefix, for example 369 instead of ML369.
PMCS INSTRUCTION MANUAL 17
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Figure 8: Devices listed in PMCS PowerBuilder

Settings
The following settings are available in the PowerBuilder window.

Device Name

This is a read-only field populated from the device name topic file. An example is 
Mill_Relay.

Device Type

This is a read-only field populated from the device type topic file. An example is EMVTC.

Server

This is a read-only field populated from the device name and based on the Server 
(GE32MTCP/GE32MODB) topic file.

Wizard

Two types of wizards are available: basic and advanced. This field indicates the available 
wizard. By default, basic is selected. The basic wizard contains a single Overview tab, 
which consists metering data and device front panel LED status. The advanced wizard 
contains multiple tabs, including the Overview, Settings, Commands, IO, and Analysis 
tabs.

Created

When a checkbox is already selected, it means that the device has already been 
configured in CIMPLICITY Project. To configure any additional devices, enable the 
appropriate checkbox.

Normally, after first installation, you ensure that all checkboxes are selected so that all 
devices are configured. Then when you later add devices, you select the checkboxes 
here, then click the Generate button to proceed with configuration. The Generate 
button is explained later in this chapter.
18 PMCS INSTRUCTION MANUAL
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OPC Port

The object linking and embedding for process control (OPC) port. The default is OPC_0.

This setting controls how CIMPLICITY manages devices. Giving several devices the same 
OPC Port, such as OPC_0, means that there is a collection of devices in a virtual port, 
similar to a group devices.

Faceplate

The faceplate style available. The default value is taken from the preference option for 
that device type:

– None

– Style 1

– Style 2

This setting is not for setting the faceplates displayed in the windows for each device (as 
shown in the next chapter).

Table 3: Faceplate styles

Device name Style 1 - 2D small faceplate Style 2 - 3D small faceplate

GTU

MVT

EMVT

469

489
PMCS INSTRUCTION MANUAL 19
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735/737

745

750/760

PQM

PQMII

UR

EPM9450

EPM9650

ELVS400

Device name Style 1 - 2D small faceplate Style 2 - 3D small faceplate
20 PMCS INSTRUCTION MANUAL
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Symbol

The list of available symbol options. The default value is taken from the preference 
option for that device type:

– None

– Style 1

– Style 2

– Style 3

Table 4: Symbols

Data Table

The available data display options. The default value is taken from the preference option 
for that device type.

Table 5: Data Table

Table 6: Data Table lines

Style No 
communication

Breaker 
open

Breaker 
closed

Breaker 
trip

Breaker 
racked out

None

Style 1

Style 2

Style 3

Data Table option Data displayed

None

2 Lines Line 1, 2

3 Lines Line 1, 2, 3

4 Lines Line 1, 2, 3, 4

5 Lines Line 1, 2, 3, 4, 5

Device Line 1 Line 2 Line 3 Line 4 Line 5

ELVS Real Power Avg Current Avg Voltage % LOAD FREQ

EMVTC Real Power Avg Current Avg Voltage % LOAD Avg PF

EMVTD Real Power Avg Current Avg Voltage % LOAD Avg PF

MVT Real Power Avg Current Avg Voltage % LOAD Avg PF

GTU Real Power Avg Current Avg Voltage % LOAD Avg PF

PQM Real Power Avg Current Avg Voltage FREQ Avg PF

PQMII Real Power Avg Current Avg Voltage FREQ Avg PF

EPM9650/9450 Real Power Avg Current Avg Voltage FREQ Avg PF

469 Real Power Avg Current Avg Voltage RPM Thermal Capacity

489 Generator Load Avg Current Avg Voltage RPM GEN LOAD

735/737 Average Current Ground Current -- -- --

745 W1 Real Power W1 Avg Current W2 Real Power W2 Avg Current FREQ

750/760 Real Power Avg Current Avg Voltage % LOAD FREQ

UR Src1 Real Power Src1 Avg Current Src1 Avg Voltage AvgPF FREQ
PMCS INSTRUCTION MANUAL 21
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The figure shows the formats for the two to five-line options, followed by an example.

Figure 9: Two to five-line formats

Figure 10: Two to five-line examples

The 735 and 737 have two lines of data available, these being average and ground 
current.

Figure 11: Display for 735/737

Figure 12: Example for 735/737

Buttons
The following buttons are available in the PowerBuilder window.

Select All Devices

Sets the Created checkboxes for all the devices to the checked state.

Clear All Devices

Sets the Created checkboxes for all the devices to the unchecked state.

ELVS Device Name

ELVS devices have a button beside the device name. Click the button to show the 
Entellisys breaker configuration window, where you specify the number of breakers and 
a name for each. The default name for each breaker is in the form BKR1, BKR2, and so 
on. To change the name, type in the field. The information is used in class object creation 
and passed on to the respective CIMPLICITY screens. When the number of breakers 
specified is greater than the actual number, blank rows appear at the end. When the 
number of breakers specified is less than the actual number, rows are removed from the 
end.
22 PMCS INSTRUCTION MANUAL
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Figure 13: Entellysis breaker configuration window

Preferences

Opens the Preferences window to configure the default one-line options for each device 
type supported in PMCS. To change a value, type in the field.

Figure 14: Set default values in Preferences window
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Help

Opens the PMCS online help window.

Generate

Initiates CIMPLICITY project creation and includes all the devices that have the Created 
checkbox enabled. It also removes any devices that were configured in the project and 
have the Created checkbox unselected. See the previous chapter for instruction on 
creating a project.

Once the Generate button is clicked, it generates a MainMenu.cim file, which can be 
viewed by clicking the Screens menu item.

Figure 15: Viewing the MainMenu.cim file

For devices with the Created checkbox enabled, based on the default options set, such 
as Faceplate, Symbol, and Data Table, the options generate as objects in the 
MainMenu.cim file and are overlaid on one another.

Figure 16: Objects in the MainMenu.cim file

Cancel

Discards any changes done in the configuration options and closes the PowerBuilder 
window.
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Device information

This chapter explains the information displayed for several devices.
The windows vary with device. Content can include the following:

• Tabs with data

• Event log button, including the ability to clear the logs

• Trend data button

• Waveform button

The buttons are inactive when not applicable, for example when no trend window was 
specified in the Objects Properties window or when waveform capture is not supported by 
a device.
Content also varies with security level. When security is enabled in your application, the 
user must have an access level greater than or equal to the access level configured for 
each tabular wizard in order to issue device commands. See the CIMPLICITY 
documentation for information on how to use security features.

469

This section explains the information displayed in PMCS for 469 motor management relays, 
which are also referred to as ML469 and SR469.

Overview tab
This tab displays

• Current

• Voltage

• Power

• System frequency

• Motor data

• Digital input status

• Relay status

• Motor status
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• Hottest stator

• Output status

Figure 17: 469 Overview tab
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Metering tab
This tab displays

• Differential currents

• Demand metering

• Energy consumption of the 469

Figure 18: 469 Metering tab
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RTD tab
This tab displays

• Resistive temperature device (RTD) information

Figure 19: 469 RTD tab
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Maintenance tab
This tab displays

• Trip data

• General timers and counters

Figure 20: 469 Maintenance tab
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Learned tab
This tab displays

• Learned motor starting data

• Learned motor load

• Learned analog input data

• Learned resistive temperature device (RTD) data

Figure 21: 469 Learned tab
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Settings tab
This tab displays

• System setup

• Thermal model

Figure 22: 469 Settings tab
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Commands tab
The following functions are available.

Table 7: 469 commands available

Figure 23: 469 Commands tab

Button Function

Reset Device Issues a reset command to the 469

Motor Start Issues Motor Start command

Motor Stop Issues Motor Stop command

Reset MWh & Mvarh Clears these values from the 469 memory

Clear Peak Demand Clears this data from memory

Clear Analog Input Min/Max Clears this data from memory

Clear RTD Maximums Resets the RTD maximums data

Clear Trip Counters Clears the trip count data from memory

Clear Last Trip Data Clears this data from memory

Reset Starter Information Clears motor start information from memory
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489

This section explains the information displayed in PMCS for 489 generator management 
relays, which are also referred to as ML489 and SR489.

Overview tab
This tab displays

• Current

• Voltage

• Power

• Voltage data

• System frequency

• Generator data

• Digital input status

• Relay status

• Generator status

• Hottest stator

• Output status

Figure 24: 489 Overview tab
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Metering tab
This tab displays

• Differential currents

• Demand metering

• Energy

Figure 25: 489 Metering tab
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RTD tab
This tab displays

• Resistive temperature device (RTD) information, where this function varies resistance 
based on temperature

Figure 26: 489 RTD tab
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Maintenance tab
This tab displays

• Trip data

• General timers and counters

Figure 27: 489 Maintenance tab
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Learned tab
This tab displays

• Learned parameter averages

• Learned analog input data

• Learned resistive temperature device (RTD) data

Figure 28: 489 Learned tab
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Settings tab
This tab displays

• System setpoints

• Thermal model

Figure 29: 489 Settings tab
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Commands tab
The following functions are available.

Table 8: 489 commands available

Figure 30: 489 Commands tab

Button Function

Reset Device Issues a reset command to the 489

Reset Breaker Information Clears the breaker data from memory

Reset Generator Information Clears the generator data from memory

Clear RTD Maximums Clears the maximum RTD data from memory

Reset MWh & Mvarh Data Clears the MWh and Mvarh data from memory

Clear Peak Demand Data Clears the peak demand data from memory

Clear Analog Input Min/Max Clears the analog input minimum/maximum data from memory

Clear Trip Counters Clears the trip counter data from memory

Clear Last Trip Data Clears the last trip data from memory
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735/737

This section explains the information displayed in PMCS for 735 and 737 products, which 
are also referred to as ML735/ML737 and SR735/SR737.

Overview tab
This tab displays

• Phase currents

• Status

• Output relays

• Trip

• Current level

Figure 31: 737 Overview tab
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Trip Data tab
This tab displays

• Pre-trip current

• Trip cause

Figure 32: 737 Trip Data tab
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Settings tab
This tab displays

• Dial settings

• Option switches

Figure 33: 737 Settings tab
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Commands tab
The following functions are available.

Table 9: 735/737 commands available

Figure 34: 737 Commands tab

Button Function

Reset/Clear Device Issues a reset command to the device.

Clear Last 5 Trip Causes Clears the last five trip causes from the device
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745

This section explains the information displayed in PMCS for 745 transformer management 
relays, which are also referred to as ML745 and SR745.

Overview tab
This tab displays

• Current

• Power

• Demand

• Energy

• Voltage information

• System frequency

• Relay status

• System status

• Conditions

• Transformer data

Figure 35: 745 Overview tab
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Harmonics tab
This tab displays

• Winding 1 - Total harmonic distortion (THD)

• Winding 1 - Harmonics

• Winding 1 - Current demand

Figure 36: 745 Harmonics tab
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Analysis tab
This tab displays

• Winding 1 - Current symmetrical components

• Differential currents

• Restraint currents

Figure 37: 745 Analysis tab
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IO tab
This tab displays

• Logic inputs

• Virtual inputs

• Output relays

• Virtual outputs

Figure 38: 745 IO tab
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Settings tab
This tab displays

• System setup

• Analog outputs

Figure 39: 745 Settings tab
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Commands tab
The following functions are available.

Table 10: 745 commands available

Figure 40: 745 Commands tab

Button Function

Reset Relay Issues a reset command to the device

Reset Peak Demand Clears the maximum demand data from the 745 memory

Reset Energy Resets the energy counters to zero

Reset Loss of Life Clears loss-of-life data from the 745 memory
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750/760

This section explains the information displayed in PMCS for 750 and 760 feeder 
management relays, which are also referred to as ML750/ML760 and SR750/SR760.

Overview tab
This tab displays

• Current

• Energy

• Voltage

• Power

Figure 41: 750 Overview tab
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Demand tab
This tab displays

• Current demand

• Three-phase power demand

Figure 42: 750 Demand tab
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Analysis tab
This tab displays

• Current symmetrical components

• Bus voltage symmetrical components

Figure 43: 750 Analysis tab
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Synchro tab
This tab displays

• Voltage phasor

• Frequencies

• Phase difference

• Frequency difference

• Synchronous voltages difference

Figure 44: 750 Synchro tab
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IO tab
This tab displays

• Contact inputs

• Contact outputs

• Virtual inputs

Figure 45: 750 IO tab
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Settings tab
This tab displays

• System setup

Figure 46: 750 Settings tab
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Commands tab
The following functions are available.

Table 11: 750/760 commands available

Figure 47: 750 Commands tab

Button Function

Reset Device Issues a reset command to the 750/760

Reset Energy Resets the energy counters to zero

Open Breaker Issues Open Breaker command

Close Breaker Issues Close Breaker command

Reset Trip Counters Resets the 750/760 trip counters to zero

Reset Max Demand Clears the maximum demand data from the 750/760 memory

Reset Arcing Current Resets the arcing current data
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ELVS

This section explains the information displayed in PMCS for EntellisysLVS (ELVS) products.

Overview tab
This tab displays

• Current

• Voltage

• System frequency

• Breaker status

• Energy

• Demand

Figure 48: ELVS Overview tab
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Analysis tab
This tab displays

• Current total harmonic distortion (THD)

• Voltage THD

• K factor

Figure 49: ELVS Analysis tab
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Demand tab
This tab displays

• Demand

• Power factor

• Energy

Figure 50: ELVS Demand tab
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Preventative Maintenance tab
This tab displays

• Operation and preventative maintenance information

• Line up options

• Per breaker options

Figure 51: Preventative Maintenance tab
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Contact Input tab
This tab displays

• Contact inputs

Figure 52: ELVS Contact Input tab
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Contact Output tab
This tab displays

• Contact outputs

Figure 53: ELVS Contact Output tab
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System Health tab
This tab displays

• Messenger hardware health

• Messenger settings validation

• Messenger communication status

• Messenger control power

Figure 54: ELVS System Health tab
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Relay Protection tab
This tab displays

• Over voltage

• Over frequency

• Under voltage

• Under frequency

• Reverse power

• Phase loss

• High current

• High resistance ground fault

Figure 55: ELVS Relay Protection tab
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Settings tab
This tab displays

• Breaker configuration

• Long time protection

• Ground fault alarm protection

• Short time protection

• Ground fault trip protection

• Instantaneous protection

Figure 56: ELVS Settings tab
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EMVTC

This section explains the information displayed in PMCS for Enhanced MicroVersa Trip C 
(EMVTC) products.

Overview tab
This tab displays

• Current

• Voltage

• System frequency

• Status

• Power factor

• Energy

• Real power demand

Figure 57: EMVTC Overview tab
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Settings tab
This tab displays

• Breaker configuration

• Long time protection

• Short time protection

• Instantaneous protection

• Protective relays

• Ground fault protection

Figure 58: EMVTC Settings tab
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Commands tab
The following functions are available.

Table 12: EMVTC commands available

Figure 59: EMVTC Commands tab

Button Function

Reset Energy Clears energy data in the device

Reset Peak Demand Clears peak demand data in the device

Reset Instantaneous Trip Counter Clears instantaneous trip counters from the device

Reset Short Time Trip Counter Clears short time trip counters from the device

Reset Long Time Trip Counter Clears long time trip counters from the device

Reset Ground Fault Trip Counter Clears ground fault trip counters from the device
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EMVTD

This section explains the information displayed in PMCS for the Enhanced MicroVersa Trip 
D (EMVTD) products.

Overview tab
This tab displays

• Current

• Voltage

• System frequency

• Status

• Power factor

• Energy

• Real power demand

Figure 60: EMVTD Overview tab
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Settings tab
This tab displays

• Breaker configuration

• Long time protection

• Short time protection

• Instantaneous protection

• Protective relays

• Ground fault protection

Figure 61: EMVTD Settings tab
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Commands tab
The following functions are available.

Table 13: EMVTD commands available

Figure 62: EMVTD Commands tab

Button Function

Reset Energy Clears energy data in the device

Reset Peak Demand Clears peak demand data in the device

Reset Instantaneous Trip Counter Clears instantaneous trip counters from the device

Reset Short Time Trip Counter Clears short time trip counters from the device

Reset Long Time Trip Counter Clears long time trip counters from the device

Reset Ground Fault Trip Counter Clears ground fault trip counters from the device
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EPM9650/EPM9450

This section explains the information displayed in PMCS for EPM9650 and EPM9450 
meters.

Overview tab
This tab displays

• Currents

• Voltages

• Energy

• Power

• System frequency

Figure 63: EPM9650 Overview tab
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Analysis tab
This tab displays present, maximum, and timestamp of maximum of

• Currents - Total harmonic distortion (THD)

• Phase Voltage - THD

• K-factor currents

Figure 64: EPM9650 Analysis tab
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Demand tab
This tab displays

• Fixed window power

• Predictive sliding window

Figure 65: EPM9650 Demand tab
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Digital tab
This tab displays

• Digital inputs

Figure 66: EPM9650 Digital tab
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Max Data tab
This tab displays the maximum and its time stamp of

• Currents

• Voltages

• Positive real power

• Negative real power

• Positive reactive power

• Negative reactive power

• Apparent power

Figure 67: EPM9650 Max Data tab
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Settings tab
This tab displays

• Current setpoints

• Voltage setpoints

• Voltage phase sequence

• CT ratio

• PT ratio

• Time settings, including time zone

Figure 68: EPM9650 Settings tab
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Commands tab
The following functions are available.

Table 14: EPM9650 commands available

Figure 69: EPM9650 Commands tab

Button Function

Reset Energy Clears the energy counters

Reset Maximums Clears the maximum values from memory

Reset Minimums Clears the minimum values from memory
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GTU

This section explains the information displayed in PMCS for Entelliguard Trip Unit (GTU) 
products.

Overview tab
This tab displays

• Currents

• Voltages

• System frequency

• Status

• Energy

• Real power demand

Figure 70: GTU Overview tab
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Status tab
This tab displays

• Trip status

• Breaker status

• Alarm status

• Primary protection

• Waveform capture data

• Relays

• Inputs

• Shunts

• Undervoltage release (UVR)

Figure 71: GTU Status tab
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Statistics tab
This tab displays

• Trip counts

Figure 72: GTU Statistics tab
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Settings tab
This tab displays

• Breaker configuration

• Long time protection configuration

• Short time protection configuration

• Instantaneous protection configuration

• Reduced energy let-through (RELT) instantaneous protection configuration

• Protective relays

• Ground fault protection configuration

Figure 73: GTU Settings tab
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Commands tab
The following functions are available.

Table 15: GTU commands available

Figure 74: GTU Commands tab

Button Function

Reset Instantaneous Trip Counter Clears Instantaneous trip counter data

Reset Short Time Trip Counter Clears short time trip counter data

Reset Long Time Trip Counter Clears long time trip counter data

Reset Ground Fault Trip Counter Clears ground fault trip counter data

Reset RELT Resets RELT

Reset Total Energy Clears total energy
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MVT

This section explains the information displayed in PMCS for MicroVersa Trip (MVT) products, 
excluding EMVTC and EMVTD.

Overview tab
This tab displays

• Current

• Voltage

• System frequency

• Status

• Power factor

• Energy

• Real power demand

Figure 75: MVT Overview tab
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Settings tab
This tab displays

• Breaker configuration

• Long time protection

• Short time protection

• Instantaneous protection

• Protective relays

• Ground fault protection

Figure 76: MVT Settings tab
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PQM/PQMII

This section explains the information displayed in PMCS for power quality meter (PQM) and 
PQMII products.

Overview tab
This tab displays

• Current

• Voltage

• Power

• Energy

• Demand

• Contact outputs

• Switch inputs

Figure 77: PQMII Overview tab
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Analysis tab
This tab displays

• Currents - Total harmonic distortion (THD) (present and maximum values)

• Phase voltages - THD (present and maximum values)

• Power quality values

Figure 78: PQMII Analysis tab
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Maximum tab
This tab displays

• Current (present value, maximum value, and time stamp of maximum value)

• Voltage (present value, maximum value, and time stamp of maximum value)

• Three-phase power (present value, maximum value, and time stamp of maximum 
value)

• Current demand (present value, maximum value, and time stamp of maximum value)

• Three-phase power demand (present value, maximum value, and time stamp of 
maximum value)

Figure 79: PQMII Maximum tab
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Settings tab
This tab displays

• System setup

Figure 80: PQMII Settings tab
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Commands tab
The following functions are available.

Table 16: PQMII commands available

Figure 81: PQMII Commands tab

Button Function

Reset Device Issues a reset command to the PQM/PQMII

Reset Energy Clears the PQM/PQMII energy counters

Reset Frequency Values Clears the PQM/PQMII maximum frequency values from memory

Reset Pulse Counters Resets the PQM/PQMII pulse counter

Reset Max THD Values Clears the PQM/PQMII maximum total harmonic distortion 
values from memory

Reset Max Demand Values Clears the PQM/PQMII maximum demand values from memory

Reset Current Min/Max Values Clears the PQM/PQMII current minimum and maximum values 
from memory

Reset Voltage Min/Max Values Clears the PQM/PQMII voltage minimum and maximum values 
from memory

Reset Power Min/Max Values Clears the PQM/PQMII power minimum and maximum values 
from memory
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UR

This section explains the information displayed in PMCS for the Universal Relay (UR) series, 
such as the B30, C30, C60, and D30. Due to the number of products available, a UR wizard 
can display between one and eight screens of data; the number of screens is determined 
by the user during wizard configuration. There are 23 tab variations possible in PMCS, 
depending on the type of UR device connected. For example, the C30 device does not 
support metering functions, so the metering and source tabs are not available for this 
device.

Overview tab
This tab displays

• Currents

• Voltages

• Energy

• Demand

• System frequency

• Status

• Event cause

Figure 82: UR Overview tab
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Analysis tab
This tab displays

• Current symmetrical components

• Voltage symmetrical components

• Breaker arcing current

Figure 83: UR Analysis tab
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Synchro tab
This tab displays

• Synchrocheck 1

• Synchrocheck 2

Figure 84: UR Synchro tab
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Contact Input tab
This tab displays

• Contact inputs

Figure 85: UR Contact Input tab
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Contact Output tab
This tab displays

• Contact outputs

Figure 86: UR Contact Output tab
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Settings tab
This tab displays

• Current transformer settings

• Voltage transformer settings

• Power system settings

Figure 87: UR Settings tab
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Commands tab
The following functions are available.

Table 17: UR commands available

Figure 88: UR Commands tab

Button Function

Reset Device Issues a reset command to the UR device

Clear Demand Clears Demand data from the device

Clear Energy Clears Energy data from the device
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Chapter 5: Software and license 
management
Software and license management

The following actions can be performed by the Administrator for software and license 
management:

• Manage activation code

• Transfer software license

• Update software

• Uninstall software

Manage activation code

The software license allows for installation on one computer. After installing PMCS on a 
computer, use the procedure here to generate an activation code and enter it . There is no 
prompt to do so; the software does not work unless the code is entered.
To unlock an installation:

1. Launch the Configurator application by clicking Start > All Programs > EnerVista 
Integrator > EnerVista Configurator.

2. Click Help > License Manager. The License Manager window opens, shown as follows.
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Figure 89: Activating a PMCS software license

3. Obtain the Site ID and Machine ID from the window.

4. Generate an activation code as follows. Log in to 
http://apps.gedigitalenergy.com/swmgr using the following credentials:

Order number: nnnnnnnn

Password: nnnnnnnn

Enter the Site ID and Machine ID, and generate the CD activation code. Record the 
number.

5. Enter the code in the Activation Code field, and click the Unlock button. This unlocks 
both PMCS and EnerVista Integrator.

Transfer software license

The license does not allow installation on more than one computer, but you can move the 
software license from one PMCS installation to another. You cannot move a complete 
installation with its database to another computer.
You look up the Site ID of the license being moved, then transfer it .
To view a Site ID:

1. At the computer on which the license is installed, launch the Configurator application.

2. Click Help > License Manager. The License Manager window opens, shown as follows.
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Figure 90: Transferring a PMCS software license

3. Obtain the Site ID from the window.

To transfer the license:

1. At the computer on which you want to install the license, log in as Administrator.

2. Launch the Configurator application.

3. Click Help > License Manager. The License Manager window opens.

4. Enter the Site ID in the New Site ID field.

5. Click the Transfer button.

Update software

After initial activation, if PMCS license manager detects any license options still available 
for upgrade, the license upgrade section is enabled in the license management window.
Updates are free for a year after purchase. Download them from the GE Multilin website at 
http://gedigitalenergy.com/multilin or ask for a new CD using the contact information 
contained in the For further assistance section.
Based on the license purchased, PMCS limits the number of installations. The license can 
be upgraded by entering a new activation code. See the Manage activation code section.
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Uninstall software

If required, the PMCS software can be uninstalled.
Uninstalling the PMCS software deletes configuration information too. It does not delete 
some files, such as error logs, system logs, and configuration records, which are created 
after the PMCS installation is complete. Since these files are not part of the initial 
installation, they are not removed by the uninstaller, and must be deleted manually. The 
SQL Express database remains.
To uninstall PMCS software:

1. Click Start > Control Panel.

2. Click Programs and Features.

3. Click the PMCS application.

4. Click Uninstall, and confirm the deletion. The PMCS software is deleted as outlined.
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